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Warranty and Liability 
Note The Application Examples are not binding and do not claim to be complete 

regarding the circuits shown, equipping and any eventuality. The Application 
Examples do not represent customer-specific solutions. They are only intended 
to provide support for typical applications. You are responsible for ensuring that 
the described products are used correctly. These application examples do not 
relieve you of the responsibility to use safe practices in application, installation, 
operation and maintenance. When using these Application Examples, you 
recognize that we cannot be made liable for any damage/claims beyond the 
liability clause described. We reserve the right to make changes to these 
Application Examples at any time without prior notice.  
If there are any deviations between the recommendations provided in these 
application examples and other Siemens publications – e.g. Catalogs – the 
contents of the other documents have priority. 

 

We do not accept any liability for the information contained in this document. 

Any claims against us – based on whatever legal reason – resulting from the use of 
the examples, information, programs, engineering and performance data etc., 
described in this Application Example shall be excluded. Such an exclusion shall 
not apply in the case of mandatory liability, e.g. under the German Product Liability 
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life, 
body or health, guarantee for the quality of a product, fraudulent concealment of a 
deficiency or breach of a condition which goes to the root of the contract 
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial 
contractual obligation are, however, limited to the foreseeable damage, typical for 
the type of contract, except in the event of intent or gross negligence or injury to 
life, body or health. The above provisions do not imply a change of the burden of 
proof to your detriment. 

 

Any form of duplication or distribution of these Application Examples or excerpts 
hereof is prohibited without the expressed consent of Siemens Industry Sector. 
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1 Preface 

Objective of the Application 

The objective is performance monitoring and diagnostics of centrifugal pumps in 
the context of SIMATIC PCS 7 plant asset management. A low-cost solution can 
be achieved by intelligent combination and logical interpretation of measured 
process values which are (mostly) already available in the DCS, in contrast to high-
end condition monitoring systems based on dedicated additional sensors, e.g. 
vibration sensors or structure-borne sound sensors. 

Main Contents of this Application Note 

The following issues are discussed in this application: 

• How to implement and configure the pump monitoring, using the PCS 7 Add-on 
product. 

• How to parameterize and commission the pump monitoring.  

• How to evaluate the pump monitoring results in the context of plant asset 
management. 

• Application example based on the PCS 7 solution template "PumpUnit".  

Validity 

Valid for PCS 7 V6.1 and V7.0. The application example is based on  
PCS 7 V7.0 SP1.  

Reference to Automation and Drives Service & Support 

This article is from the internet application portal of the Industry Automation and 
Drives Technologies Service & Support. Clicking the link below directly displays the 
download page of this document.  

http://support.automation.siemens.com/WW/view/en/42460161 

 

http://support.automation.siemens.com/WW/view/en/42460161�
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2 Introduction Pump Monitoring 
 

NOTE A general overview of pump monitoring in PCS 7 is provided by the White Paper 
„SIMATIC PCS 7 Monitoring Block PumpMon - Function Block for cost-effective 
Monitoring and Diagnostics of Centrifugal Pumps “  
http://www.automation.siemens.com/w2/efiles/pcs7/pdf/76/Paper_PumpMon_AM
_CM_EN.pdf 

2.1 Area of Application 

Pumps are one of the most common rotating machines in process plants. The 
PCS 7 Add-on product PumpMon [1.] offers a cost-effective solution for monitoring 
and diagnosis of centrifugal pumps. It is based on an intelligent combination and 
logical interpretation of measured process values which are (mostly) already 
available in the DCS, in contrast to high-end condition monitoring systems based 
on dedicated additional sensors, e.g. vibration sensors or structure-borne sound 
sensors. 

The function is applied to 

• provide warnings against potential pump damage due to unfavorable operating 
conditions (blockage, dry run, gas conveyance, cavitation, overload, incorrect 
direction of rotation); 

• provide early detection of developing pump degradation (wear and tear, 
decreasing pump efficiency); 

• optimize pump design over the long term by means of statistical analysis of the 
operating data and load profiles. This way, potentials for energy savings can 
be detected. 

The block can be used for electrically driven centrifugal pumps with both constant 
and variable speed. 

PumpMon can inform operators via alarm and warning messages about any 
violations of the nominal pump operating range and about deviations from the 
expected characteristic, and make this data available for further processing via the 
block outputs. Of course, all the output values can be processed further by means 
of the usual PCS 7 tools (calculations, trend recording, alarm history, and so on). 

 

TI PI FIC PI M

PumpMon 

 
Figure  2-1: P&I-diagram of pump with associated sensors and actors incl. pump monitoring 

 

http://www.automation.siemens.com/w2/efiles/pcs7/pdf/76/Paper_PumpMon_AM_CM_EN.pdf�
http://www.automation.siemens.com/w2/efiles/pcs7/pdf/76/Paper_PumpMon_AM_CM_EN.pdf�
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The block itself is designed purely for diagnostic purposes and, as such, does not 
intervene directly in the operation of the pump. This means that it can be deployed, 
or even retrofitted, without the risk of affecting the process. If required, active 
intervention (e.g. to reduce the speed of the pump in response to imminent 
cavitation) can be achieved by evaluating the block outputs. 

Cavitation is the formation and collapse of vapor bubbles of a flowing liquid. During 
the operation of centrifugal pumps, such vapor bubbles can appear due to (locally) 
excessive flow velocities: higher velocity causes lower pressure in the fluid. If the 
pressure of the liquid falls below its vapor pressure, vapor bubbles will emerge. If 
the pressure rises again in flow direction, the bubbles collapse: the gas inside the 
bubble suddenly condenses. During this implosion, so called „jet-impacts“ will 
occur, causing pressure and temperature shock waves, that usually are much 
higher than tolerable by the materials of pump rotor or pump housing. The surface 
of pump rotor or pump housing are damaged permanently and finally destroyed. 
Even a small amount of cavitation reduces the efficiency (the delivery height) of the 
pump. Full cavitation can even cause the pump delivery to crash completely. 

 

2.2 Functions 

The PumpMon function block offers the following functions [1.]: 

2.2.1 Analysis and Graphical Representation of Characteristics of Pump 
Data and Operation States 

• Power values: electric power intake of the motor, calculated mechanical power 
output of the motor, hydraulic power delivered by the pump. 

• Delivery height characteristic: display of expected delivery height as a function 
of flow (in case of speed-controlled pumps converted via the current speed), 
with minimum and rated flow, „live“ actual operating point and relative/absolute 
deviation of operating point from characteristic line. 

• Power characteristic: display of required (mechanical) pump power as a 
function of flow, with „live“ operating point und relative deviation; in addition 
display of the expected hydraulic pump efficiency as a function of flow with 
calculated actual efficiency. 

• NPSH characteristic: logarithmic display of the NPSHr value required for 
cavitation-free operation as a function of flow, with actual NPSHa value 
(calculated from intake pressure and vapor pressure of medium). NPSH stands 
for „Net Positive Suction Head“. 

• Histograms: statistical evaluation of pump operating states with respect to flow 
(pump load) and cavitation reserve. 

2.2.2 Diagnostic Functions 

The function block offers the following diagnostic functions for warning operators in 
case of unfavorable operating states: 

• limit violations of power values, 

• flow lower than minimal flow - extreme turndown, danger of overheating, 

• flow higher than nominal flow - overload, 

• deviation of operating point from delivery height characteristic, i.e. loss of 
delivery height - indicates gas conveyance, cavitation or blockage, 
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• deviation of operating point from power characteristic, 

• deviation of operating point from efficiency characteristic, 

• NPSH actual value approaching the NPSH required characteristic - early 
warning with respect to cavitation. 

2.2.3 Teach Function 

Point wise teaching of reference pump characteristics via coordinates of 
interpolation points in good state (reference state) of the pump. 

 

2.3 Typical Application Examples 

• Pumps that fail more frequently than the average, 

• Pumps that are in danger of cavitation, e.g. in water/wastewater sector [6.], 

• Pumps where chemical fouling occurs, 

• Pumps that are operated in another way than initially planned, 

• Pumps that show unaccountable variations in power consumption, 

• Applications where the designated behavior and performance of pumps is to 
be proven. 
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3 Implementation of Pump Monitoring 

3.1 Installation of SIMATIC PCS 7 Add-on Product 

The installation of the SIMATIC PCS 7 Add-on Product is performed by the setup 
program of the delivery CD. The function block can be installed in PCS 7 Version 
6.1 or higher. 

After installation, there is a library called „PCS 7 PumpMon Lib V10“ available in 
Simatic Manager. After selection of the function block PumpMon in the blocks 
folder, the online help can be called via function key F1. 

If the PumpMon faceplate is not displayed properly in OS, the PumpMon setup 
must be installed not only on the ES and OS server, but also on each OS client. 

 

3.2 Configuration 

With respect to engineering, two completely different use cases are discussed: 
retrofitting pump monitoring in a running plant, or greenfield engineering of the 
complete automation around a pump incl. pump monitoring. 

3.2.1 Greenfield Engineering of the Complete Automation Around a Pump 
(Based on Solution Template) 

Around pumps, there is a typical combination of actors and sensors, that (together 
with the pump) provide the equipment module "create defined (controlled) flow of a 
fluid and monitor it". Therefore it is reasonable to standardize the pump in form of a 
"pump unit", together with the actors and sensors that belong to this equipment 
module. The typical control and interlock functions, that are necessary for all 
pumps in a similar way, and the pump monitoring (using the PumpMon function 
block) all belong to the automation of the pump unit. 

If pump speed is fixed, PI flow control is acting on a control valve next in line. The 
pump itself is controlled via a direct starter e.g. Simocode. 

A lock valve in front of the pump makes sure that no fluid is travelling through the 
pump if the pump is switched off. Besides flow indication for flow control, there are 
sensors for pressure at suction side and load side, and for medium temperature. A 
binary fluid detector observes if there is any fluid at all. 

The pump drive is stopped or prevented from starting if 

• the inlet (lock) valve is closed, or 

• the control valve at the outlet is nearly closed by the flow controller for some 
time (e.g. longer than 10s in a position with less than 5% opening). 

It is recommended to realize two different types of pump units in the library part of 
a PCS 7 multi project: one pump unit for fixed speed pumps with flow control via 
control valve, and one for variable speed pumps with flow control via pump speed. 
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3.2.2 Retrofitting of Pump Monitoring in a Running Plant 

In the following it is assumed that there is the basic automation around the pump 
incl. interlock logic and flow control already in the PCS 7 project. 

The function block PumpMon is inserted in a CFC chart in the appropriate folder of 
the technological hierarchy. Because PumpMon connects sensor signals from 
different measurement tags, you will typically generate a new chart for it. This chart 
be located in the hierarchy folder to which the pump belongs, or in a separate 
hierarchy tree plant diagnosis or "performance station". In a performance station 
similar to the PCS 7 maintenance station, target group specific information could 
be collected and displayed. While the maintenance station is targeted to 
maintenance personal, the target group for the performance station are plant 
managers, process and control engineers that are responsible for optimizing plant 
operation. 

3.2.3 CFC Engineering 

The function block requires:  

• effective electrical power intake of motor  Input variable PoElec 

• flow rate of pumped medium  Input variable Flow 

• pump intake pressure  Input variable P_In 

• pump delivery pressure  Input variable P_Out 

• a binary signal indicating if motor is running  Input variable Running 

If measured pressure values only determine pressure difference to surroundings: 

• air pressure to be added as an offset to measured pressure values  input 
parameter P_Atmos 

For cavitation monitoring additionally: 

• temperature of pumped medium  input parameter Temp 

For variable speed pumps (input parameter ConstSpd = FALSE) additionally: 

• pump speed  input variable Speed 

If the frequency converter delivers the mechanical (shaft) power of the motor: 

• mechanical power  input variable PoMech 

  

These signals have to be provided by signal links or specified in case of constant 
values (e.g. air pressure, often also intake pressure or temperature of pumped 
medium). The values are normalized to SI units if necessary, by using the input 
parameters *Offs and *Fact .  

If you are normalizing temperature values, pay attention to the details in the 
description [2.]! 
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Figure  3-1: Linking of PumpMon function block in CFC 
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4 Parameter Specification and 
Commissioning 

4.1 Required Data for Motor, Pump and Pumped Medium 

The technical data listed in the following sections are required for configuration of 
pump monitoring and have to be provided beforehand. 

4.1.1 Data of Electrical Motor  

General 

• Rated speed  

For standard motors: 

• Rated power 

• Rated efficiency   

For non-standard motors, e.g. canned motor pumps: 

• Polynomial to calculate the delivered mechanical shaft power as a function of 
consumed electrical power (must be delivered by supplier of motor/pump)    

4.1.2 Data of Pump  

• Minimal flow 

• Rated flow 

• Delivery characteristic = H/F- characteristic 

• Power characteristic = P/F- characteristic 

• Efficiency characteristic 

NOTE The pump efficiency is calculated in the PumpMon function block as a ratio of 
hydraulic power and mechanic shaft power. Sometimes this efficiency is not 
identical to the efficiency rated in the pump specification: in the pump 
specification there is frequently only the efficiency of the rotor, while other power 
losses (e.g. eddy currents, bearing losses, friction losses) are ignored. Therefore 
it is to be expected that the pump efficiency calculated by PumpMon is a little bit 
below the rotor efficiency rated in the pump specification. 

 

 

For cavitation monitoring additionally: 

• NPSHr characteristic 

• Diameter of pump intake and pressure socket  

• Eventually recommended minimal distance to NPSHr characteristic for long 
term operation (typically 0,5m) 
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4.1.3 Data of Pumped Medium  

• Density 

For cavitation monitoring additionally: 

• Antoine coefficients, if medium is different from water 0 – 100ºC, or 

• Algorithm for calculation of vapor pressure as a function of temperature if 
Antoine equation is not applicable. 

4.2 Parameter Input in Faceplate or CFC 

4.2.1 Parameters of Electrical Motor  

Specification of calculation method for mechanical shaft power (CFC only) 

1. For standardized motors (PolyAct = FALSE, ConvAct = FALSE, default 
setting) 
 Calculation based on rated efficiency and rated power via internal function in 
PumpMon 

2. For other motors, e.g. canned motor pumps (PolyAct = TRUE, ConvAct = 
FALSE): 
 Calculation based on motor characteristic line by means of a polynomial of 
the 4th order; the coefficients K0 to K4 must be supplied by the manufacturer 
of the motor/pump. 

3. If the frequency converter delivers both the electrical and the mechanical 
power directly l (PolyAct = FALSE, ConvAct = TRUE): 
 no further parameterization required, besides the linking of PoMech as 
mentioned above, eventually normalization by PoMechOffs and PoMechFact  

Parameters for standardized motors: 

• Rated power PoRate (in faceplate, view „parameters“, or in CFC) 

• Rated efficiency Eta (in faceplate, view „parameters“, or in CFC) 

• For all three power variables (electric, mechanic and hydraulic power) the low 
range for the faceplate bar graphs (MO_PVLR_Elekt, MO_PVLR_Hydr, 
MO_PVLR_Mech, normally = 0) and the high range (MO_PVHR_Elekt, 
MO_PVHR_Hydr, MO_PVHR_Mech, normally a little bit above rated power) 
have to be specified in CFC. 

 

For all motor types: 

• Number of pole pairs PolePair (in CFC) 

 

For motors with variable speed 

• Take away tick mark „constant speed in faceplate view „parameters“, or 
parameter ConstSpd = „variable“ (FALSE) in CFC 

• Rated speed SpdRate (in faceplate, view „parameters“, or in CFC) 

• Please refer to hints on slip correction in [2.] ! 
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4.2.2 Parameters of Pump 

• Characteristic lines for delivery height, power and efficiency (in faceplate view 
"ParTable", or in case of need in CFC) 

The characteristic lines can have up to 15 interpolation points; if not all of them are 
used, the spare values must be set equal to the last valid value, to fulfill the 
requirement of monotonically increasing x-values. 

The values on the x-axis (flow) do not need to be equally spaced. The time base 
for the flow values must be specified (TimeBase = 3600s when scaling in m3/h). 

The extrapolation above and below the range of the characteristic line is horizontal, 
i.e. if the flow value is smaller than the leftmost interpolation point, the first y-value 
is written to the output, if the flow value is larger than the rightmost interpolation 
point, the last y-value is written to the output. 

Teach function: The characteristics from the pump documentation should normally 
be used. If the documentation is not available or the current status of the pump is 
to be used as a reference (e.g. because the sensor placement is not ideal), the 
individual pump operating points can also be approached manually and the values 
determined here for the flow rate, delivery height, power, and efficiency can be 
used as interpolation points for the characteristic lines. The teach function can be 
used as a tool for entering the interpolation points for the characteristics. The 
actual values calculated for the delivery height, power, and efficiency are used as 
points in the characteristics. The values can then be corrected manually if required. 

Sometimes only a part of the characteristic is relevant for operation in a 
continuously operated plant, and even for teaching it is difficult to move to other 
operating regions. In such cases it is sufficient to teach only the section of the 
characteristic that is relevant for operation. Attention: the requirement for 
monotonously rising x-values must be fulfilled anyway! In order to achieve a 
reasonable optical display of the characteristic, the line can be continued 
consistently to the left and to the right of the teached section, and filled with 
plausible values. 

• Minimal flow MinFlow (in faceplate, view „parameters“, or in CFC) 

• Rated flow OptFlow (in faceplate, view „parameters“, or in CFC) 

For cavitation monitoring additionally: 

• Characteristic line for NPSH value (in faceplate, view "ParTable", if needed in 
CFC) 

The NPSH characteristic has its own interpolation points for flow (FlowNp1, ..., 
FlowNp15), because this characteristic line cannot be teached at all.   

• Diameter of intake socket and pressure side socket (in faceplate, view 
„parameters“, or in CFC) 

 

In case of bypass around pump: 

• Bypass (set tick mark in faceplate, view „parameters“, or in CFC). 
In a pump with bypass, the measured flow is not correct, because the flow 
through the bypass is not measured. In this case the function block will 
calculate an estimated flow value based on mechanical power. Therefore the 
monitoring of deviations from the power characteristic is no more possible. 
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4.2.3 Parameters of Pumped Medium  

• Density (in faceplate, view „parameters“, or in CFC) 

For cavitation monitoring additionally: 

• If medium is different from water 0 – 100ºC: Antoine coefficients AntA, AntB, 
AntC, AntFact ; or for external calculation of vapor pressure (Antoine = 
FALSE)  linking of input P_Vapor [bar] (CFC only) 

4.2.4 Message Parameters for Dry Run, Blockage and Power Deviations  

• Power limits for the detection of blockage PoBlk and dry run PoDryRun (in 
faceplate, view  „tolerances“, or in CFC) 

In case of dry run, the valve at the suction side is closed, there is no fluid inside the 
pump, the flow will be zero and the electrical power decreases to a minimal value 
(typically < 30% of rated power). 

 !  

WARNING 

In case of dry run the pump bearings will be overheated, and will be 
destroyed in a short time. If there is no fluid at all inside of the pump, there 
can be sparks emitted between rotor and housing, which must be 
completely avoided especially in explosion protection areas. The 
PumpMon function block is able to detect a pump running dry during 
operation in time, but if the pump is started without any fluid, the reaction 
of the PumpMon will be too late. Therefore in explosion-proof areas, 
additional action is to be taken to avoid starting a pump without fluid, e.g. 
application of a binary flow detector ("Liquifant") in the suction pipe. 

 

 

In case of blockage, the valve at the pressure side (or both) are closed and the flow 
is zero as well. The value of the electric power is low, but not as low as in case of 
dry run, because there is still some fluid circulated inside the plump (typically < 
40% of rated power). 

 !  

WARNING 

During blockage, the friction heat generated by the pump motor cannot be 
transported away by the pumped medium, and the medium is heated. This 
situation is very dangerous, especially if the valves on both sides of the 
pump are closed. If the evaporating temperature of the medium is reached, 
and the resulting pressure cannot find a way out, a steam explosion can 
blast the pump housing and cause mortal danger. 

 

 

• Suppression time SuppTime, during this time after motor startup, all messages 
of the function block are suppressed (in faceplate, view „parameters“, or in 
CFC). 

• For each of the deviations from the characteristic lines, there is a limit for the 
maximal relative deviation: Tol_Height, Tol_Power, Tol_Eta, Tol_NPSH, all in 
[%], and an associated time delay: T_Height, T_Power, T_Eta, T_NPSH (in 
faceplate, view „tolerances“, or in CFC). A message is generated if the limit is 
violated for more than the specified time delay. Proposal for default values: 
Tol_Height, Tol_Power, Tol_Eta = 5%, Tol_NPSH = 0,5m; T_Height, 
T_Power, T_Eta, T_NPSH = 300 sec. During operation, application specific 
individual values for these limits must be found. Hint: the upper limit of 50s for 
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the time delays is only implemented in the faceplate. You can enter higher 
values in CFC or modify the limit in the *.pdl file of the faceplate. 

• For each of the power variables (electrical, mechanic and hydraulic), there is 
monitoring of upper and lower alarm and warning limits, including message 
suppression according to PCS 7 standards. Limits and message suppression 
can be operated in faceplate view "tolerances" with access level "higher 
process controlling", or in CFC. 

• All limit monitoring functions include hysteresis. The hysteresis of electrical, 
mechanic and hydraulic power can be modified in faceplate view "tolerances"; 
the other hysteresis values can only be modified in CFC. 
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5 Evaluations for Plant Asset Management 
Different results of the calculations performed by PumpMon are relevant for 
different target groups working in a process plant, and differ with respect to 
urgency. 

Diagnoses like actual blockage or dry run have to be immediately announced as an 
alarm to the operator, because these operating conditions will destroy the pump in 
a short time. An automatic emergency stop of the pump is normally not initiated by 
PumpMon, but rather by binary interlock logics, e.g. in case of closed valves. In 
principle, the interlocks can be augmented by evaluation of binary output variables 
of PumpMon.  

Other operating conditions like e.g. cavitation will result in pump damage after 
some time - however it is advisable to react promptly anyway. In this case 
diagnosis information has to be announced to the plant operator and to 
maintenance personal. 

Hints like "Pump efficiency is more than 10% below characteristic line" do not call 
for immediate action, but are helpful to find optimization potential. 

Following these considerations, it is reasonable to evaluate the information created 
by PumpMon in a target group oriented way. 

5.1 Maintenance Request  

A maintenance request announced by a maintenance message is not generated by 
the PumpMon function block itself, but by the associated AssetMon function block 
[3.]. The AssetMon is a universal proxy function block for mechanic and process 
assets in the Maintenance Station of PCS 7. It is located in the hierarchy folder of 
the Maintenance Station and not in the normal plant hierarchy. Its faceplate 
therefore appears in the Maintenance Station and not in the Operator Station. 

The Electronic Device Description (EDD) containing the master data of the pump is 
attached to the AssetMon block, allowing to access the pump like an intelligent field 
device in the context of asset management. 
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5.1.1 Specify Pump Master Data 

In order to generate the EDD for a pump, you need a so called PLT-ID [3.].  

The PLT-ID is a connection parameter between a PDM object (parameter data 
EDD) and the faceplate in the Maintenance Station. The PLT-ID is linked to the 
PDM object. The PDM object is generated in the SIMATIC Manager as follows: 

1. Select “View > Process device plant view” in SIMATIC Manager. 

2. Select “Insert > SIMATIC PDM > TAG”. 

3. Highlight the inserted TAG object and select the context menu command 
“SIMATIC PDM > Device Selection...” 

4. In the tree structure CFC > DATA_OBJECTS > CFC >, select AssetMon and 
close the dialog with "OK". 

5. In the context menu select “Open Object” and enter all necessary data in 
the parameter assignment screen form. 

6. Select “File > Save”. 

7. The parameter assignment screen form is closed. 

8. Select the TAG object and then “Tools > SIMATIC PDM > Create PLT-
ID”. 

You can then assign parameters for the generated PLT-ID at the associated 
parameter "PLT_ID". Note: The PLT-IDs cannot be changed or deleted individually. 

Now maintenance requests and master data of the pump are displayed together to 
maintenance personal. 

 

5.1.2 Linking and Parameterization of AssetMon Function Block 

Inside the PumpMon block, a histogram of load distribution over time is generated, 
and a histogram of cavitation states. The number of operating hours in a certain 
load range is visualized as bar height in the histogram. The bar height (number of 
operating hours) of each bar is available as a separate output variable at the 
PumpMon function block. 

Please check the NPSHa limit where pump damage starts to occur. Typically this 
will start if the actual NPSHa value is below the required NPSHr value, i.e. the 
deviation from the NPSHr characteristic is negative. Therefore, take a sum of the 
related output variables DevNpsh1+DevNpsh2+DevNpsh3 and link it the input 
variable PV_1 of the associated AssetMon function block, as shown in Figure  3-1 
by the Add4P block "CaviTime". 
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Figure  5-1: Linking of AssetMon function block for a pump 
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Define the limits for Maintenance Request LR_PV_1, Maintenance Demand 
LD_PV_1 and Maintenance Alarm LA_PV_1 such that after the specified number 
of hours in cavitation the desired maintenance request is generated. 

If you know that the pump after a certain amount of operating hours in overload or 
underload typically needs maintenance, you can link further analog inputs e.g. 
PV_2 of AssetMon to the respective histogram output variables e.g. Load1 of 
PumpMon and define alarm limits for the operating hours.  

If the pump needs maintenance after a defined number of operating hours, 
independent of operating conditions, you can take the overall number of operating 
hours since initialization of the load statistics from the output PumpMon.LoadTime, 
and you do not need a separate counter for operating hours. In this case, the load 
statistic must be re-initialized after each maintenance action (by clicking the reset 
button in the faceplate), in order to reset the counter to zero. 

 

5.2 Stress-minimized Operation 

For the operation of centrifugal pumps you need sufficient suction head (pressure 
on the suction side of the pump), such that the pump is running in intended 
operation state, i.e. with less than 3% loss of delivery height due to cavitation. For 
pumps that are in danger of cavitation from time to time, the application of a 
dedicated anti-cavitation controller can be helpful. 

The aim of the approach described in [4.] is "stress-minimized" and energy efficient 
operation of pumps (“stress-minimized operation“, SmO), based on established 
pump monitoring. An additional, supervisory function can exploit the information on 
actual stress intensity in current operation, and interact with the conventional 
control logic, such that stress-intensive operating conditions are reduced or 
completely avoid by optimal process control. The intervention of the SmO-function 
is restricted to reasonable limits. A compromise between the main targets of 
process control and the target of stress minimization is searched. 

The idea is to establish an anti-cavitation controller in parallel to the flow controller, 
which is acting on the same manipulated variable [8.]. 

    

 
FIC 

KIC PumpMon

Flow.PV

AbwNpsh
DISV 

+

 

Figure  5-2: Principle of anti-cavitation controller 

 

The controlled variable of the anti-cavitation controller is the deviation of NPSHa 
from a limit critical for the emergence of cavitation. 



 5 Evaluations for Plant Asset Management 

 5.2 Stress-minimized Operation 
 

22 
PumpMonitoring 

V1.0, Entry ID: 42460161 
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 2
0

1
0 

A
ll 

rig
h

ts
 r

e
se

rv
e

d
 

SP-Deadband 

SP = 10m 

 
Figure  5-3: NPSH characteristic line, coordinate axis for controlled variable and setpoint of 

anti-cavitation controller 

 

For example, the NPSH setpoint is set constant to 10m above the NPSHr line. The 
anti-cavitation controller is a proportional-only controller with a deadband of 8m. By 
doing without integral action you can avoid that the controller must be switched to 
tracking mode if he has no access to the actor. The deadband makes sure that the 
anti-cavitation controller does not interfere with the flow controller during normal 
operation. However, if the NPSH deviation is approaching the critical limit, the anti-
cavitation controller will begin to intervene, by closing the valve at the pressure side 
a little bit. Due to this intervention, flow will decrease, and the actual NPSH value 
moves horizontally to the left, which means that the distance to the critical limit will 
increase.  

As soon as the anti-cavitation controller becomes active, the integral action of the 
flow controller is frozen in the respective direction, such that the flow controller can 
not work with its own integral action against the anti-cavitation controller  
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Figure  5-4: CFC chart of anti-cavitation controller "SmO1" in connection with the flow controller FIC (here 

PID1) 
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6 Application Example 
There is a PCS 7 solution template for automation of a pump unit in [8.]. The pump 
unit allows generating a controlled flow using a fixed speed pump. 

 

 
Figure  6-1: PCS 7 solution template pump unit 

 

The pump unit includes the following functions and the related measurement tag 
instances: 

• Control of pump motor via direct starter Simocode 

• PI flow control using a controlled valve at the pressure side 

• Lock valve at the suction side 

• Interlock logic, c.f. section  3.2.1 

• Pump monitoring using the PumpMon function block 

• Maintenance management using the AssetMon function block, c.f. section  5.1 

• Sequential function control (SFC) for organized startup and shutdown of the 
pump unit 

• Optional: Stress-minimized operation to avoid cavitation  (c.f. section  5.2) 
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6.1 Realization of Interlocks 

 
Figure  6-2: Pump motor control via Simocode, the interlocks are acting on the input variable LOCK of 

function block SmcDir 

 

 
Figure  6-3: Interlocking the pump drive if lock valve at suction side is closed (not Valve.FbOpened), or 

control valve at pressure side is closed to much (FlowControl.LMNR_I < 5) for some time 
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6.2 Simulation of Different Operating States  

6.2.1 Intended Operation 

During intended operation the actual delivery height is at the expected level, i.e. at 
the characteristic line. 

When modifying the setpoint of the flow controller, the actual operating point is 
moving along the characteristic line to the left or to the right. Temporary deviations 
during the transient response are no reason for concerns, because the 
characteristic line is only a model of steady state behavior. Concluding from this, 
alarm delays for deviations from characteristic lines have to be specified long 
enough, such that the pump itself and all related measurement values reach a 
steady state after a setpoint step before the alarm becomes active. 

 
Figure  6-4: Delivery height characteristic during intended operation. The actual delivery 

height (green dot) is at the expected line. 
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6.2.2 Delivery Height Losses by Wear and Tear or Gas Conveyance  

In the simulation example, decreasing pump efficiency can be simulated by 
reduction of delivery pressure. For this, you can "falsify" the scaling factor 
PumpMon.P_OutFactor artificially, i.e. reduce it from 1 to 0.8. 

 
Figure  6-5: Delivery height losses in characteristic line view 

 

You observe that the actual operating point moves away downwards both from the 
delivery height characteristic and from the efficiency height characteristic and it 
changes color from green to red. A warning message "Delivery height deviates 
from characteristic..." and "Pump efficiency deviates from characteristic..." is 
generated.  
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Figure  6-6: Efficiency losses in characteristic line view.  

Electrical power is still at the olive green characteristic line (Figure  6-6), but 
hydraulic power is less than expected, i.e. the actual efficiency (in transformation 
from mechanic shaft power to hydraulic delivery power) is below the respective 
orange line. 

 

The following causes for delivery height losses have to be considered: 

• Gas conveyance, 

• Cavitation or 

• Wear and tear. 

You check the Npsh-characteristic to make sure, if cavitation really is the cause 
(c.f. section  6.2.3). 

A worn crack can be detected by trend recording of the deviation DevDelHi from 
the delivery height characteristic over a longer time range. The deviation will 
increase slowly but consistently.  

On the other hand, delivery height losses caused by gas conveyance can appear 
suddenly, and disappear suddenly. Causes for gas conveyance have to be 
searched at the suction side, e.g. 

• Suction of air at leakages with depression, 

• Excess rotation speed of agitators in upstream tanks, or 

• Chemical reactions that generate gases. 
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Special case incorrect direction of rotation: If the motor was mounted incorrectly 
and rotates in the wrong direction, you observe both a strong delivery height loss 
(>40%) and a small deviation from the power characteristic (<20%). This case is 
signaled by a warning message "Wrong direction of rotation". 

  

6.2.3 Cavitation 

In the simulation example cavitation can be simulated by reduced suction pressure. 
You falsify the scaling factor PumpMon.P_InFactor artificially, i.e. reduce it 
stepwise from 1 to 0.4. 

 
Figure  6-7: Npsh-characteristic during intended operation of the pump. 

 

The available suction pressure (interpreted in meters hydrostatic head) is 3m 
above the suction pressure required for this flow according to the characteristic 
line.  

 

You then observe that the actual NPSH operating point is approaching the 
cavitation limit from upside, and shortly before it will cross the limit, will change 
color from green to red. Approaching the cavitation limit is interpreted as an early 
warning of cavitation danger, and alerted by a warning message „Npsh-value is too 
low“. After falling below the limit line, an alarm "Cavitation!" is generated. 
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Figure  6-8: Npsh characteristic line during cavitation.  

The available suction head is 0.29m below the required suction head for this flow 
according to characteristic line. At the same time, pump delivery height is crashing. 
Cavitation will erode the pump rotor in the course of time. 
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6.2.4 Dry Run 

In the simulation example dry run (c.f. section  4.2.4) can be simulated by closing 
the suction side valve. Take the lock valve in manual mode and close it. The pump 
will be shut down by interlocks of pump unit. 

 
Figure  6-9: Automatic interlock shutdown of pump unit caused by dry run, visible in Simocode faceplate of 

pump drive by status "Locked" and motor "Off". The reason is the closed suction side valve 
(now grey instead of green like in Figure  6-1) 

 

Additionally, the shutdown can be triggered by evaluation of the respective binary 
output PumpMon.Q_DryRun , but the direct logical connection to valve state must 
be implemented due to safety reasons anyway. PumpMon can naturally detect dry 
run even when the suction side valve is open, if e.g. the suction side tank has 
fallen empty. 

6.2.5 Blockage 

In the simulation example, blockage (c.f. section  4.2.4) can be simulated by closing 
the pressure side valve. Take the flow controller FlowControl/PID in manual mode, 
and specify a value of 3% for the manipulated variable. After some seconds the 
pump will be shut down by interlocks of the pump unit, similarly to the case of dry 
run. 

Additionally the shut down could be triggered by evaluation of the respective binary 
output PumpMon.Q_Blk. This way the shutdown will be triggered even if blockage 
cannot be detected by valve position, because it is caused e.g. by a foreign particle 
in the pipeline. 
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6.2.6 Overload Operation 

In the simulation example overload operation of the pump drive, caused by 
excessive friction of bearings, can be simulated by excessive electric power intake. 
Modify the scaling factor PumpMon.PoElectFactor artificially, e.g. increase it 
stepwise from 1 to 1.8. 

 
Figure  6-10: Overload operation in bar graph of power values 

 

Together with electric power, the mechanic power calculated by the motor model 
will also increase. If one of the related limits is violated, a warning or alarm 
message like e.g. "Electrical Power HH-Alarm" will be generated. 
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7 Summary 
The function block PumpMon calculates the following variables, that are not directly 
measured: 

• Delivery height 

• Mechanic power 

• Hydraulic power 

• Pump efficiency 

• NPSH value 

• Statistical distribution of flow values ("load distribution") 

Pump diagnosis works with the following logic to detect faulty operating conditions: 

• Blockage: is detected from electric power. This correlation is independent of 
motor model. Increased robustness by signal filtering. 

• Dry run:  is detected from electric power. This correlation is independent of 
motor model. Increased robustness by signal filtering. 

• Faulty operation (out of intended operation): is detected from delivery height 
loss (specified deviation from delivery height characteristic). 

• Cavitation: is detected from delivery height loss in conjunction with NPSHa 
value (if safety margin of 0.5m to NPSHr characteristic is violated). 

• Pump wear and tear: can be detected externally 

– With respect to cavitation: summation of operating hours in cavitation. 

– With respect to worn crack: enduring deviation from delivery height 
characteristic (e.g. 48h permanent deviation), that is not caused by gas 
conveyance. 

• Overload: is detected from electric power. 

• Bad pump efficiency: is detected from deviations of actual pump efficiency 
(hydraulic / mechanic power) from efficiency characteristic. 
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 Flow Diff.-
pressure 
via  
pump 

Electr. 
power 

Pressure 
in front 
of pump 

Temp. 
medium 

Density Vapor 
pressure 

Blockage (x) (1)  x (2)     

Dry run (x) (1)  x (2)     

Gas conveyance  x x    [x] (4)  

Cavitation x x  x [x] (4)  [x] (5) 

Pump wear  x (x) (3) x     

Overload   x     

Bad pump 
efficiency   

x x x     

Table  7-1 Correlation of measurable variables and detectable problems 

Legend: 

 x  Measurement required (mandatory) 

(x)  Measurement helpful, but not mandatory  

[x]  Depends on application - see remarks 

 

Remarks: 
(1) Not urgently required, but useful for additional plausibility check. 
(2) Is used for calculation of mechanic power. 
(3) In delivery height characteristic more significant than in power characteristic. 
(4) If not constant, sometimes as additional value from flow measurement field 
device. 
(5) If Temperature is not constant (then specify constant value); the function block 
includes calculation of vapor pressure by Antoine equation. In other cases, vapor 
pressure must be calculated from temperature by external CFC functions and 
linked to the respective PumpMon input. 
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